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Preface 

Copyright 

© Agilent Technologies, Inc. 2021, 2022. No part of this manual may be reproduced in 
any form or by any means (including electronic storage and retrieval or translation into a 
foreign language) without prior agreement and written consent from Agilent 
Technologies, Inc. as governed by United States and international copyright laws. 

Contact Information 

 

Agilent Technologies, Inc. 
5301 Stevens Creek Blvd. 
Santa Clara, CA  95051 

Worldwide Sales and Support 

www.agilent.com/en/contact-us/page 

Technical Support and Service 

www.agilent.com/en/support 

bio.tac@agilent.com 

Instrument service and repair is available worldwide at one of our international service 
centers and in the field at your location. 

Customer Care 

bio.CustomerCare@agilent.com 

European Coordination Center 

 
Agilent Technologies Denmark ApS 
Produktionsvej 42, 2600 Glostrup, Denmark 
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UK Responsible Person (UKRP) 

 Agilent LDA UK Ltd. 
5500 Lakeside 
Cheadle Royal Business Park 
Cheadle, Cheshire SK8 3GR 

Intended Use Statement 

The Epoch 2 is an absorbance microplate spectrophotometer and intended to be used for 
the examination of clinical specimens to analyze their characteristics in relation to a variety 
of analytes including in human serum and cells. 

Incident Reporting 

Any serious incident that has occurred in relation to the device shall be reported to the 
manufacturer and the competent authority, or appropriate regulatory body, in the country 
or region in which the user is established. 

Quality Control 

It is considered good laboratory practice to run laboratory samples according to 
instructions and specific recommendations included in the assay package insert for the 
test to be conducted. Failure to conduct Quality Control checks could result in erroneous 
test data. 

Safety Notices 

Pay special attention to the following safety notices in all product documentation.  

-WARNING- A WARNING notice denotes a hazard. It calls attention to an operating 
procedure, practice, or the like that, if not correctly performed or adhered 
to, could result in personal injury or death. Do not proceed beyond a 
WARNING notice until the indicated conditions are fully understood and 
met. 

-CAUTION- A CAUTION notice denotes a hazard. It calls attention to an operating 
procedure, practice, or the like that, if not correctly performed or adhered 
to, could result in damage to the product or loss of important data. Do not 
proceed beyond a CAUTION notice until the indicated conditions are fully 
understood and met. 
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Warnings and Precautions 

Electrical Hazards 

-WARNING- Internal Voltage. Always turn off the power switch and unplug the power 
supply before cleaning the outer surface of the instrument. 

-WARNING- Power Rating. The instrument’s power supply or power cord must be 
connected to a power receptacle that provides voltage and current within 
the specified rating for the system. Use of an incompatible power 
receptacle may produce electrical shock and fire hazards. 

-WARNING- Electrical Grounding. Never use a plug adapter to connect primary power 
to the external power supply. Use of an adapter disconnects the utility 
ground, creating a severe shock hazard. Always connect the power cord 
directly to an appropriate receptacle with a functional ground. 

-WARNING- Service. Only qualified technical personnel should perform service 
procedures on internal components. 

-CAUTION- Power Supply. Use only the power supply shipped with the instrument, 
and operate it within the range of line voltages listed on it. 

Chemical/Environmental 

-WARNING- 

 

Potential Biohazards. Some assays or specimens may pose a biohazard. 
Adequate safety precautions should be taken as outlined in the assay’s 
package insert. Always wear safety glasses and appropriate protective 
equipment, such as chemical-resistant rubber gloves and apron. 

-WARNING- Liquids. Avoid spilling liquids on the instrument; fluid seepage into 
internal components creates a potential for shock hazard or instrument 
damage. If a spill occurs while a program is running, stop the program and 
turn off the instrument. Wipe up all spills immediately. Do not operate the 
instrument if internal components have been exposed to fluid. 

-CAUTION- Liquids. Do not immerse the instrument, spray it with liquid, or use a 
dripping-wet cloth on it. Do not allow water or other cleaning solution to 
run into the interior of the instrument. If this happens, contact Technical 
Support. Do not soak the touchscreen. 

-CAUTION- Environmental Conditions. Do not expose the instrument to temperature 
extremes. For proper operation, temperature near the instrument should 
remain within the range in the Specifications section of this document. 
Performance may be adversely affected if temperatures fluctuate above 
or below this range 

-CAUTION- Sodium Hypochlorite. Do not expose any part of the instrument to the 
recommended diluted sodium hypochlorite solution for more than 20 
minutes. Prolonged contact may damage the instrument surfaces. Be 
certain to rinse and thoroughly wipe all surfaces. 



Preface Page 8 of 51 
 

Agilent BioTek Epoch 2 Instructions for Use  Agilent Technologies, Inc. 
1771011I Revision C 

-CAUTION- Lubricants. Do not apply lubricants to moving parts. Lubricant on 
components in the carrier compartment will attract dust and other 
particles, which may cause the instrument to produce an error. 

Components 

-WARNING- Accessories. Only accessories that meet the manufacturer's specifications 
shall be used with the instrument. 

-CAUTION- Shipping Hardware. All shipping hardware must be removed before 
operating the instrument and reinstalled before repackaging the 
instrument for shipment. 

-CAUTION- Touchscreen. Use your fingertip to operate the touchscreen. Do not use a 
sharp stylus or pencil on the touchscreen. Doing so will damage the 
touchscreen's surface. You can use a stylus designed for resistive 
touchscreens. 

-CAUTION- Touchscreen. Avoid strong solvents, such as alcohol, acetone, ammonium 
chloride, methylene chloride, and hydrocarbons. These will permanently 
damage the touchscreen. Avoid fibrous materials, such as paper towels, 
which can scratch the touchscreen. Dirt particles and cleaning agents will 
get trapped in the scratches. Never spray solutions directly on the 
touchscreen. 

-CAUTION- Spare Parts. Only approved spare parts should be used for maintenance. 
The use of unapproved spare parts and accessories may result in a loss of 
warranty and potentially impair instrument performance or cause damage 
to the instrument. 

-CAUTION- Service. Only qualified technical personnel should perform service 
procedures on internal components. 

Intended Product Use 

-WARNING- Software Quality Control. The operator must follow the manufacturer’s 
assay package insert when modifying software parameters and 
establishing reading methods. It is considered good laboratory practice to 
run laboratory samples according to instructions and specific 
recommendations included in the assay package insert for the test to be 
conducted. Failure to conduct quality control checks could result in 
erroneous test data. 

-WARNING- Data Reduction. No limits are applied to the raw measurement data. Data 
exported via computer control must be analyzed by the operator. The 
performance characteristics of the data reduction software have not been 
established with any laboratory diagnostic assay. Users must evaluate this 
instrument and PC-based software in conjunction with their specific 
assay(s). This evaluation must include the confirmation that performance 
characteristics for the specific assay(s) are met. 
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-WARNING- Unspecified Use. Failure to operate equipment according to the guidelines 
and safeguards specified in the product user documentation could result 
in a hazardous condition. 

-CAUTION- Use of labware other than described in this document can result in 
positioning errors during program execution. 
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Symbols 

 

Caution 

 

Warning; Biological hazard 

 

Disposal Notice: Dispose of the instrument according to Directive 
2012/19/EU, “on waste electrical and electronic equipment (WEEE)” or 
local ordinances 

 
Consult instructions for use or consult electronic instructions for use 

 
In vitro diagnostic medical device 

 

CE Marking — indicates compliance with the requirements of the In Vitro 
Diagnostic Regulation (2017/746) 

 

Authorized representative in the European Community/European Union 

 
Manufacturer 

 

Date of manufacture 

 
Catalogue number 

 
Serial number 

 

TÜV SÜD Certification Mark – Type tested; production monitored 

IP20 Ingress Protection - Product protected against solid objects up to 12 
millimeters. Not protected from liquids. 

 

This product complies with environmental protection use period as 
defined in People’s Republic of China Electronic Industry Standard 
SJ/T11364-2006. Toxic or hazardous substances will not leak or mutate 
under normal operating conditions for 40 years. 

 

UK Conformity Assessed marking is a certification mark that indicates 
conformity with the applicable requirements for products sold 
within Great Britain. 
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Temperature limit  

 

Humidity limitation  

 

 
Unique device identifier 

 
Model number 

 

Importer 
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Conformance to Standards 

The Epoch 2 meets the requirements of the following standards: 

2014/35/EU – Low Voltage Directive  
2014/30/EU – EMC Directive 
2017/746 – In Vitro Diagnostic Regulation 
2011/65/EU (with exemptions) and (EU) 2015/863 – RoHS Directives 
2012/19/EU – WEEE Directive as amended by (EU) 2018/849 

2006/42/EC of the European Parliament and of the Council of 17 May 2006 on 
machinery 

 

Standard Description 

IEC QC 080000 IEC Quality Assessment System for Electronic 
Components (IECQ System) - Hazardous Substance 
Process Management (HSPM) System Requirements 

UL 61010-1 UL Standard for Safety Electrical Equipment For 
Measurement, Control, and Laboratory Use; Part 1: 
General Requirements 

EN 61010-1 Safety Requirements for Electrical Equipment For 
Measurement, Control, and Laboratory Use – Part 1: 
General Requirements 

EN 61010-2-010 Safety Requirements for Electrical Equipment For 
Measurement, Control, and Laboratory Use – Part 2-010: 
Particular requirements for laboratory equipment for the 
heating of materials 

EN 61010-2-101 Safety Requirements for Electrical Equipment For 
Measurement, Control, and Laboratory Use – Part 2-101: 
Particular requirements for in vitro diagnostic (IVD) 
medical equipment  

CAN/CSA C22.2 No. 61010-1 Safety Requirements for Electrical Equipment For 
Measurement, Control, and Laboratory Use – Part 1: 
General Requirements 

CAN/CSA C22.2 No. 61010-2-010 Safety Requirements for Electrical Equipment For 
Measurement, Control, and Laboratory Use – Part 2-010: 
Particular requirements for laboratory equipment for the 
heating of materials 

CAN/CSA C22.2 No. 61010-2-101 Safety Requirements for Electrical Equipment For 
Measurement, Control, and Laboratory Use – Part 2-101: 
Particular requirements for in vitro diagnostic (IVD) 
medical equipment  
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EMC Information and Technical Description 

The Epoch 2 conforms to: 

Emissions: 

EN55011/CISPR 11, Class A 
CFR Title 47 FCC Part 15 Subpart B, Class A 
ICES-001, Issue 5, Class A (CAN ICES-001(A)/NMB-001(A)) 
ACMA AS/NZS CISPR 11, Class A 

Immunity: 

EN/IEC 61326-1 and 61326-2-6 
ELECTRICAL EQUIPMENT FOR MEASUREMENT, CONTROL AND LABORATORY USE 
PART 2-6: PARTICULAR REQUIREMENTS FOR (IVD) MEDICAL EQUIPMENT 

Ingress Protection Code 

IP 20. Protected against solid foreign objects of 12.5 mm diameter and greater. No 
protection against water. 

Disposal 

Dispose of the instrument according to Directive 2012/19/EU, “on waste electrical and 
electronic equipment (WEEE)” or local ordinances. 
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Installation 
 

Important Information 

-CAUTION- Shipping Hardware. All shipping hardware must be removed before 
operating the instrument and reinstalled before repackaging the 
instrument for shipment. 

• This chapter contains installation and setup tasks for the Epoch 2 and accessories. 
Perform the tasks in the order presented. 

• Save all packaging materials. Be sure to use packaging materials supplied by the 
manufacturer when shipping the reader. Using other forms of commercially 
available packaging, or failing to follow the repackaging instructions, may void your 
warranty. 

• During the unpacking process, inspect the packaging, reader, and accessories for 
shipping damage. If the reader is damaged, notify the carrier and your Agilent 
representative. Keep the shipping boxes and the packaging materials for the 
carrier's inspection. 

Package Contents  

• Epoch 2 instrument model per the sales order 
• Epoch 2 User Manual on USB flash drive 
• Power supply 
• Power cord  
• USB cable  
• Screwdriver 
• Cuvette holder (“C” models) 
• Software and optional accessories per the sales order, unless shipped separately 

Models 

Part Number Touchscreen Cuvette Port Incubation Shaking 

EPOCH2NS-SI No No Yes Yes 

EPOCH2NSC-SI No Yes Yes Yes 
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EPOCH2TS-SI Yes No Yes Yes 

EPOCH2TSC-SI yes Yes Yes Yes 

 

Unpack the Box 

 

Save the packaging, in case you need to ship the instrument for service/repair. 
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Remove the Shipping Hardware   

-CAUTION- Shipping Hardware. All shipping hardware must be removed before 
operating the instrument and reinstalled before repackaging the 
instrument for shipment. 

 

1. Pull open the microplate carrier access door. 

2. Use the supplied screwdriver to remove the two shipping bracket holders (PN 
1032190). 

3. Remove the carrier shipping bracket (PN 1332048) by lifting it up to disengage 
the pin from the floor of the instrument. 

4. Store the bracket and holders in case the instrument needs to be shipped. 

5. Remove the tape covering the cuvette port, if equipped. 

 

 

Select an Appropriate Location  

Install the reader on a level, stable surface in an area where an operating temperature 
between 18°C and 30°C (models with a touchscreen; “TS”) or 18°C and 40°C (models 
without a touchscreen; “NS”) can be maintained.  

The reader is sensitive to extreme environmental conditions. Avoid: 

• Excessive humidity. Condensation directly on the sensitive electronic circuits can 
cause the instrument to fail internal self-checks. The humidity must be in the range 
of 10–85%, non-condensing. 

• Excessive ambient light. Bright light may affect the reader’s optics and readings, 
reducing its linear range. 

• Dust. Readings may be affected by extraneous particles in the microplate wells. A 
clean work area is necessary to ensure accurate readings. 
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Prepare the Host Computer 

Follow instructions supplied with Gen5 to install the necessary software. 

• Ensure the computer meets the minimum system requirements as described in the 
Gen5 Instructions for Use. 

• You must have administrator privileges to install Gen5. Log in to Windows as 
“Administrator” or consult your IT department for assistance. 

Connect the Host Computer and Reader 

1. Turn off the computer. 

2. Using the supplied USB cable, connect the square end of the cable to the USB port 
on the rear of the reader. 

3. Connect the other end of the cable to an available USB port on the computer. 

4. Turn on the computer. 

Install the Power Supply 

-WARNING- Power Rating. The instrument’s power supply or power cord must be 
connected to a power receptacle that provides voltage and current within 
the specified rating for the system. Use of an incompatible power 
receptacle may produce electrical shock and fire hazards. 

-WARNING- Electrical Grounding. Never use a plug adapter to connect primary power 
to the external power supply. Use of an adapter disconnects the utility 
ground, creating a severe shock hazard. Always connect the power cord 
directly to an appropriate receptacle with a functional ground. 

-CAUTION- Power Supply. Use only the power supply shipped with the instrument, 
and operate it within the range of line voltages listed on it. 

 

1. Connect the power cord to the external power supply. 

2. Locate the power inlet on the rear of the reader. 

3. Plug the rounded end of the power supply's cord into the power inlet. 

4. Plug the other end of the power cord into an appropriate power receptacle. 
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Install the Cuvette Holder 

Applies only to models with a cuvette port. 

Insert the cuvette holder into the cuvette port on the front of the reader. Magnets 
secure the holder in place. 

 

Turn on the Reader and Run a System Test 

Allow the reader to settle at room temperature before you turn it on. 

1. On the front of the reader, at the base, locate the power switch. 

2. Turn on the reader and allow it to run its power-up system test. Wait at least two 
minutes. When the test is completed, the reader ejects the microplate carrier. If 
the reader is equipped with a touchscreen (and not connected to a computer), 
the Main Menu is displayed. 

If the test fails: Touchscreen models: an error message indicating the problem 
appears. If the problem is something you can fix, turn off the instrument, fix the 
problem, and turn the instrument back on. If the test continues to fail, contact 
Technical Support. Other models: contact Technical Support. 

3. (Optional) Press the lighted blue button on the front of the reader to store the 
microplate carrier in its chamber. 
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Establish Communication 

On the host computer, start Gen5 and log in if prompted. 

1. From the main screen, select System > Instrument Configuration and click Add. 

2. Set the Reader Type to Epoch 2. 

3. Perform one of the following steps, as applicable: 

• Select Plug & Play. 

• Set the Com Port to the computer's COM port to which the reader is 
connected.  

4. To verify that Gen5 can communicate with the instrument, click Test Comm. 

Troubleshooting 

If the communication attempt is successful, Gen5 displays a success message. Return to 
the main screen. If the communication attempt is not successful, try the following: 

• Is the reader connected to the power supply and turned on? 

• Is the communication cable firmly attached to both the reader and the 
computer? 

• Did you select the correct Reader Type/instrument in Gen5? 

• Try a different COM Port or use Plug & Play. 

• Did you install the USB driver software? 

If you remain unable to get Gen5 and the reader to communicate with each other, 
contact Technical Support. 

Verify Performance 

Refer to the Instrument Testing section for Absorbance Test procedures. 
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Repackaging and Shipping Instructions 

Please read the information provided below before preparing the Epoch 2 for shipment. 

• Contact Technical Support before returning equipment for service.  

• Decontamination prior to shipment is required by the U.S. Department of 
Transportation regulations. 

• If the Epoch 2 has been exposed to potentially hazardous material, decontaminate 
it to minimize the risk to all who come in contact with the instrument during 
shipping, handling, and servicing. The Maintenance chapter contains 
decontamination instructions. 

• Ensure the microplate carrier is empty. Spilled fluids can contaminate the optics 
and damage the instrument. 

• Install the shipping hardware (see next section). 

• The instrument’s packaging design is subject to change. If the instructions in this 
document do not apply to the packaging materials you are using, contact Technical 
Support for guidance. 

• Be sure to use packaging materials supplied by the manufacturer. Other forms of 
commercially available packaging are not recommended and can void the warranty. 

• If the packaging materials have been damaged or lost, or if the same set has been 
used more than four times, order replacement part number 7203003. 

• The shipping box, accessories box, foam caps, and other items are included as a 
whole set under this part number and cannot be ordered separately. 

Install the Shipping Hardware 

-CAUTION- Shipping Hardware. All shipping hardware must be removed before 
operating the instrument and reinstalled before repackaging the 
instrument for shipment. 

Refer to the drawing on page 17. 

1. Retract the microplate carrier. 

2. Turn off the reader. Unplug the power supply from the outlet and from the 
connector on the back of the reader. 

3. Disconnect the USB cable from the reader (if using a computer). 

4. Using a screwdriver, reattach the shipping bracket to the carrier. 

5. If applicable, remove the cuvette holder and apply tape over the cuvette port to 
prevent contamination during shipment. 



Installation Page 22 of 51 
 

Agilent BioTek Epoch 2 Instructions for Use  Agilent Technologies, Inc. 
1771011I Revision C 

Repackage the Instrument and Accessories 

Refer to the drawing on page 16. 

1. Place the foam corner cubes into the bottom of the shipping box. 

2. Place the reader inside the original plastic bag. Set the reader into the foam 
cubes in the bottom of the box. 

3. Slide the packing sleeve over the reader. 

Touchscreen models: If you are using replacement packaging materials, remove the two 
pullouts so the sleeve fits over the touchscreen: 

 
 

4. Place the accessory tray in the box. Place accessories in the tray as shown below: 

 
 

5. Close the box. Secure it with shipping tape. 
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Getting Started 

External Components 

Touchscreen Models 

  

1. USB port for data 
output 

2. microplate carrier 
access door 

3. cuvette holder  
(if equipped) 

4. power on/off 
5. carrier in/out,  

status LED 
 

  

  

6. USB port for printer  

7. power inlet 
8. USB port for host 

computer  
(if used) 
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Non-Touchscreen Models 

  

1. microplate carrier 
access door 

2. cuvette holder  
(if equipped) 

3. power on/off 
4. carrier in/out,  

status LED 

 

  

  

5. power inlet 
6. USB port for host 

computer  

  

 

Optional Printer 

Refer to the printer's manual for installation and setup instructions. 
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Using the Touchscreen 

-CAUTION- Touchscreen. Use your fingertip to operate the touchscreen. Do not use a 
sharp stylus or pencil on the touchscreen. Doing so will damage the 
touchscreen's surface. You can use a stylus designed for resistive 
touchscreens. 

Main Menu 

 

Up to 60 uniquely named protocols can be saved on the reader at one time, excluding 
the predefined Take3 protocols. 

Protocols created through the touchscreen are limited to a single read step and, for 
Endpoint, Kinetic, and Take3 protocols, up to 12 blank wells. Use Gen5 if your assays 
require more complex reading methods or plate layouts. 

The left side of the Main Menu lists the five most recently used protocols. The tabbed 
sections in the middle contain the protocols created for each protocol type, and the 
Take3 plate (if used). To run an existing protocol, tap its name, define the wells to be 
read if fewer than the full plate, and tap Start.  

The right side of the Main Menu provides access to the following features: 

Quick Define and run an Endpoint read, perform a standalone shake, or 
incubate a plate. Quick reads do not support shake or delay actions, 
and they read the full plate.  

Protocol Edit, create (and save), delete, and copy protocols. Through this menu 
option, protocols support shake and delay actions. 

Results Provides access to results for the 12 most recently run protocols. Tap a 
protocol name to view its results, and then tap the screen to cycle 
through the available data sets (e.g., Raw data, Delta OD, Blanked 
data). 

Instrument Run a system test, define date/time settings, enable output to a 
printer and/or USB flash drive, configure a Take3 plate, and control 
temperature. 
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Confirm or Set the Time and Date 

From the Main Menu, tap Instrument and select the Configuration tab. 

 

• Tap the Time / Time Format and Date / Date Format fields to change the 
current settings. 

• Set the Decimal Symbol to a period or comma. 

• Set the List Separator, used in exported .csv files, to a comma or semicolon. 

Define Output Formats for Results Data 

From the Main Menu, tap Instrument and select the Output tab. 

 

Output Types 

• To print results (Endpoint only), select Print or Save&Print. 

• To save results to a USB flash drive, select Save to USB or Save&Print. 

Data Types 

• Raw: The raw measurement value for each well. 

• Delta OD: Applicable when a secondary wavelength is selected in an 
absorbance protocol. This is the calculated value for each well of the 
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primary wavelength measurement minus the secondary wavelength 
measurement. 

• Blanked: The calculated value for each well, after subtracting the average of 
the blank well(s). 

Save Format options 

• Report: .csv file containing raw data, Delta OD, and/or blanked data, as 
available. This file can be opened in Excel or other spreadsheet software. 

• Gen5 Input: .txt file containing only raw data. This file can be opened in 
Gen5 using the Read from File option.  

• Prompt: Choose an output format after the plate has been read. 

Define and Start a Quick Endpoint Read 

From the Main Menu, tap Quick. 

 

1. Select the Plate type and define the appropriate settings for your assay. 

2. Place the plate on the carrier and tap Start to run the protocol. 

3. When the read is finished, the results are displayed and ready for output 
according to the settings defined under Instrument > Output. 
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Define and Start a Standalone Shake 

From the Main Menu, tap Quick and select the Shake tab. 

 

1. Set Shake Mode to Linear (side-to-side), Orbital (circle), or Double Orbital (in a 
figure-eight pattern). 

2. Set the Duration, from 1 second to 2 hours 45 minutes. 

3. For Orbital shake modes, set the Speed to Slow or Fast. 

4. Adjust the Frequency, if needed. The cycles per minute updates as the slider 
moves. The measurement in mm indicates the distance the carrier travels during 
the shake. 

5. Place the plate on the carrier and tap Start to shake the plate. 

Incubate a Plate 

From the Main Menu, tap Quick and select the Incubate tab. 

 

1. Check the Active box. 

2. Define a Set point from 18°C to 65°C (64.4°F to 149°F). Heating begins 
immediately. 

3. Move the plate carrier in, if it is currently out.  
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4. When the temperature displayed at the top of the screen reaches the set point, 
move the carrier out, insert the plate, and move the carrier back in. 

The minimum set point must be ambient room temperature plus 4°C.  

Condensation Control 

A temperature Gradient can be applied to reduce the risk of condensation when 
using microplate lids. When no gradient (0) is applied, the heaters above and below 
the plate operate at the same (setpoint) temperature. This is recommended if the 
plate has no lid, or condensation is not a problem when lids are used.  

When a gradient (0.1 to 2.0) is applied, the heaters above the plate operate slightly 
higher than the set point and the heaters below the plate operate slightly lower 
than the set point. The gradient represents the temperature separation between 
the top and bottom heaters. This differential should serve to reduce or eliminate 
condensation. 

In the example below, the Set point is 37°C and the Gradient is 1.0: 

 

Some experimentation with the gradient setting may be necessary to achieve 
optimal results with your assay. 

Create and Save a Protocol 

1. From the Main Menu, tap Protocol > Create. 

2. Use the onscreen keyboard to enter a name for the protocol, then tap Save. Note 
that the protocol name is limited to 18 characters. 

3. Set the Read Mode to Endpoint, Kinetic, or Spectral. 

4. Define the protocol parameters and then tap Save. 

 

37.4˚C 37.4˚C 

36.4˚C 36.4˚C 
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Endpoint Protocols 

 

Plate: Options include standard 6-, 12-, 24-, 48-, 96-, and 384-well plates, Cuvette 
(if equipped), and Take3 (if configured). 

Primary WL and (optional) Secondary WL: Define the primary and (optional) 
secondary wavelength in the range 200 to 999 nm. 

Microplates and Take3 only: 

Read Speed: Select Normal (optimum performance) or Sweep (optimum speed). 
See the Specifications section to compare the performance and timing 
specifications. 

Blanks: Tap to open a plate matrix and select up to 12 Blank wells. For a 384-well 
plate, the matrix is displayed in quadrants; tap the 1-2-3-4 box to change the view. 

Activity Before Read options: 

• Set a delay (up to 2 hours, 45 minutes) before the read. 

• Select a shake mode of Linear (side-to-side), Orbital (circle), or Double 
Orbital (in a figure-eight pattern). Set a Duration (up to 2 hours 45 minutes) 
to shake the plate before the read begins. Adjust the Frequency, if needed. 
The cycles per minute updates as the slider moves. The measurement in 
mm indicates the distance the carrier travels during the shake. 

When finished, tap Save. The protocol name is added to the Main Menu. 

If your Endpoint assay requires incubation, activate Temperature Control before 
reading the plate. From the Main Menu, select Instrument and tap the Temperature 
tab. 
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Kinetic Protocols 

 

Time: Specify the full duration of the kinetic analysis, up to 272:15:00 (hh:mm:ss). 
Note: You can stop a protocol while it is running, before the Time expires; results 
will be saved. 

Interval: Specify the interval (delay) between reads, up to 2:45:00 (hh:mm:ss). The 
Interval must be shorter than the Time. 

Number of kinetic reads: Calculated automatically, based on the Time and Interval 
settings. Cannot exceed 100 reads. 

Considerations: The Interval must be long enough to support the protocol parameters 
and the number of microplate wells selected for reading. If a shake is specified, its 
Duration may result in a longer interval than defined in the protocol. To test the 
settings, save the protocol and return to the Main Menu. Tap the protocol to run it, 
select the wells if not reading the full plate, and tap Start. The Minimum Kinetic Interval 
will display if the defined Interval is too short. Run the protocol using the displayed 
interval, or return to the protocol and modify its parameters. 

Plate: Options include standard 6-, 12-, 24-, 48-, 96-, and 384-well microplates, 
Cuvette (if equipped), and Take3 (if configured). 

Primary WL: Define a wavelength in the range 200-999 nm. Only one wavelength is 
supported through the touchscreen; use Gen5 if your assay has other 
requirements. 

Microplates and Take3 only: 

Read Speed: Select Normal (optimum performance) or Sweep (optimum speed). 
See the Specifications section to compare performance and timing specifications. 

Blanks: Tap to open a plate matrix and select up to 12 Blank wells. For a 384-well 
plate, the matrix is displayed in quadrants; tap the 1-2-3-4 box to change the view. 

Options (tap Edit): 

If applicable, check Eject the plate when done. If unchecked, the plate will remain 
in the chamber after the last kinetic read. 

If the assay requires incubation: 
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1. Check the Active box. 

2. Define a Setpoint from 18°C to 65°C. Heating will begin when you start to 
run the protocol.  

3. Check Turn off when done to turn the incubator off after the last kinetic 
read is completed. 

The minimum setpoint must be ambient room temperature plus 4°C. See the 
Specifications section for more information on temperature control. 

Shake Before Each Read: Select a shake mode of Linear (side-to-side), Orbital 
(circle), or Double Orbital (in a figure-eight pattern). Set a Duration (up to 2 hours 
45 minutes) to shake the plate before each kinetic read or select Continuous to 
shake the plate whenever it is not being read. Adjust the Frequency, if needed. The 
cycles per minute updates as the slider moves. The measurement in mm indicates 
the distance the carrier travels during the shake. 

• Continuous shaking typically results in higher ODs and lower CVs.  

• To define a kinetic protocol with a shake before the first read only, use 
Gen5. 

When finished, tap Save. The protocol name is added to the Main Menu. 

Spectral Scan Protocols 

 

Plate: Options include standard 6-, 12-, 24-, 48-, 96-, and 384-well plates, Cuvette 
(if equipped), and Take3 (if configured). 

Start WL and End WL: Define the start and end wavelengths. The full spectral range 
is 200 to 999 nm. 

Step Size: Define an increment (in nm) for measurement. For example, if the Start 
WL is 200 and the Step Size is 10, measurements are taken at 200, 210, 220, and so 
on until the End WL is reached. 

The number of spectral data points cannot exceed 100. 
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Microplates and Take3 only: 

Calibrate first: Set to Yes (optimum performance) to perform calibration at all of 
the specified wavelengths when a plate read is initiated. Set to No (optimum 
speed) to perform calibration at only those wavelengths not yet calibrated since 
the reader was turned on. 

Shake Before Read: Select a shake mode of Linear (side-to-side), Orbital (circle), or 
Double Orbital (in a figure-eight pattern). Set a Duration (up to 2 hours 45 minutes) 
to shake the plate before spectral scanning begins. Adjust the Frequency, if 
needed. The cycles per minute updates as the slider moves. The measurement in 
mm indicates the distance the carrier travels during the shake. 

When finished, tap Save. The protocol name is added to the Main Menu. 

Run a Protocol  

Kinetic protocols: If a temperature set point is defined in the protocol, you can turn the 
incubator on manually by selecting Instrument > Temperature. Otherwise, the 
incubator will turn on when you start the protocol. Wait until the set point is reached, 
or tap Override to read the plate. 

1. From the Main Menu, tap a protocol in the Most Recent list or under one of the 
available tabs. The Run Protocol screen displays the defined parameters: 

 

2. To read a partial plate, tap Full Plate and select the well(s) to read. Tap Save. 

3. Press the blue lighted button on the front of the reader to eject the plate carrier. 

4. Place the microplate on the carrier and tap Start. 

When the read is finished, the results are displayed and ready for output according to 
the settings defined under Instrument > Output. 

The reader saves results for the last 10 Endpoint/Take3 and last 2 Kinetic/Spectral 
protocols that were run. The next set of saved results will overwrite the oldest set for 
the read mode only with your acknowledgment.  
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Edit, Delete, or Copy a Protocol 

Edit a Protocol 

1. In the Main Menu, tap Protocol. 

2. Tap the protocol that you want to modify, then tap Edit. 

3. Make any desired changes, then tap Save. 

Delete a Protocol 

1. From the Main Menu, tap Protocol. 

2. Tap the protocol you want to delete, then tap Delete.  

Copy a Protocol 

1. In the Main Menu, tap Protocol. 

2. Tap the protocol you want to copy, then tap Copy. 

3. Enter a name for the new protocol, then tap Save. 

4. Make any desired changes, then tap Save. 

View or Output Results Stored on the Reader 

1. In the Main Menu, tap Results. Results for the last 10 Endpoint/Take3 and last 2 
Kinetic/Spectral protocols are listed by read mode/file name. Tap the protocol 
for which you want to view or output results. The results are displayed on the 
touchscreen.  

• Tap the data set name at the top of the screen to view protocol details, 
including the start date/time, final status, and protocol parameters. 

• Endpoint: Tap the screen to toggle through the available data sets. 

• Kinetic/Spectral: Tap a well to view its kinetic curve or spectral scan. 

• If a well displays “OVR,” the measurement exceeds (overflow) the maximum 
absorbance measurement range: 4.000 OD (normal read speed, or cuvette); 
3.000 OD (sweep read speed). 

• If a well displays “???,” a result (for example, blank subtraction) could not be 
calculated. 

2. Tap the green button in the upper-right corner of the display. The results are 
printed and/or saved to the USB flash drive, depending on the read mode and 
defined output format. 
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Run a Take3 Session  

Using the Touchscreen 

The Epoch 2 is preprogrammed with seven Take3 protocols, available for use after a 
Take3 plate has been defined and aligned on the reader.  

The protocols measure at 260, 280, and 320 nm and cannot be edited. For the 
nucleic acid protocols, a secondary wavelength of 230 nm can be selected at run 
time. For all seven protocols, a spectral scan may also be selected.  

Protocol name Mass Extinction 
coefficient 

Secondary Ratio WL 
(run time option) 

Spectral Scan 
(run time option) 

dsDNA 50 230 nm 240–300 nm 

RNA 40 230 nm 240–300 nm 

ssDNA 33 230 nm 240–300 nm 

1 Abs@1cm =  
1 mg/mL 10 - 260–320 nm 

BSA 6.7 - 260–320 nm 

IgG 13.7 - 260–320 nm 

Lysozyme 26.4 - 260–320 nm 
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Define and Align a Take3 Plate 

Ensure that the glass slide is clean before running the alignment procedure. Refer to the 
Take3/Take3 Trio User Manual for cleaning instructions. 

If you remove or replace the glass slide, perform the Pathlength Calibration procedure 
described in the Take3/Take3 Trio User Manual and then run the alignment procedure 
described below. Update the Pathlength Values on the touchscreen with the new values 
generated through the Pathlength Correction procedure described in the user manual. 

The reader can be configured with only one Take3 plate at a time. 

This procedure ensures that the Take3 slide's microspot positions are captured correctly 
in the reader's software. Upon completion, the Take3 tab appears on the Main Menu 
and contains the preprogrammed Take3 protocols.  

1. From the Main Menu, tap Instrument and select the Take3 tab. 

 

2. Enter the plate’s Serial Number. 

3. Place the plate on the carrier. Tap Required (or Realign) and then Start to 
perform the alignment. The process takes several minutes to complete. 

4. Change the Blank threshold CV% if the default value does not meet your assay 
requirements. This setting compares all replicates of a blank to determine 
cleanliness of the microspots (dirty microspots can skew the %CV). Set the value 
smaller to have a tighter tolerance on the deviation of cleanliness of the 
microspots, or set it higher to relax the tolerance. 

5. Tap Edit and enter the pathlength values that either came with the Take3 plate 
or were generated through the Pathlength Correction procedure in the Take3 
User Manual. 
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6. When finished, tap Back and Home to return to the Main Menu.  

Run a Take3 Protocol 

1. On the Main Menu, tap the Take3 tab and select the protocol to run. 

2. Select 1 to 12 wells as Blank and tap Continue. 

3. On the Run Protocol screen, select options as applicable: 

• Concentration units: Select the unit of measure for the export file.  

• Secondary Ratio WL (230 nm): Available for nucleic acid protocols.  

• Spectral Scan: Perform a spectral scan for the wavelength range displayed (1 
nm step size), in addition to the endpoint reads.  

. 

4. Place the Take3 plate on the carrier and tap Start. 

• If the Take3 Blank Masking screen appears and reports that the CV Status is 
DIVERGING, the %CV of the blank wells is higher than the Blank threshold 
CV% defined for the plate. Invalid blank wells are highlighted in red. Tap a 
well to mask (exclude) it from blank average and %CV calculations. When 
the remaining unmasked blank wells are valid, the Approve button 
illuminates. If the number of valid blank wells is sufficient for the assay, tap 
Approve, otherwise select Cancel and address the problem (e.g., clean the 
slides).  
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• At least one blank well is required. If all blank wells are masked, the CV 
Status is INVALID. 

• Each masked blank well will be flagged with an asterisk in the printed and 
exported results. 

5. When the read is finished, the results are displayed and ready for output 
according to the settings under Instrument > Output.  

 

Gen5 Software 

Gen5 software supports all Epoch 2 reader models. This section provides brief instructions 
for creating a protocol and running an experiment. For more information, refer to 
publications provided with Gen5 and the Gen5 help system (Help > Help Topics). 

In Gen5, a protocol contains instructions for controlling the reader and (optionally) 
instructions for analyzing the data retrieved from the reader. At a minimum, a protocol 
must specify the procedure you wish to run. After creating a protocol, create an 
experiment that references the protocol. You will run the experiment to read plates and 
analyze the data. 

1. In the Gen5 Task Manager, select Protocol > Create New. 

2. Open the Procedure dialog. If prompted to select a reader, select Epoch 2 and 
click OK. 

3. Select a Plate Type. 

Gen5 stores measurements and other characteristics for individual plate types in a 
database. It is essential that you select (or define) the plate type to match the assay 
plate. Otherwise, results may be invalid. See the “Plate Type Database” topic in the 
Gen5 Help for instructions. 

4. Add steps to the procedure for reading the plate. Click Validate to verify that the 
reader supports the defined steps, and then click OK. 

5. Optionally, perform any of these steps to analyze and report the results: 

• Open the Plate Layout dialog and assign blanks, samples, controls, 
and/or standards to the plate. 

• Open the Data Reduction dialog to add data reduction steps. Categories 
include Transformation, Well Analysis, Curve Analysis, and Qualitative 
Analysis. 

• Create a report or export template via the Report/Export Builders. 

6. Select File > Save and give the protocol an identifying name. 

7. In the Gen5 Task Manager, select Experiment > Create using an existing 
protocol.  

8. Select the desired protocol and click OK. 
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9. Select a plate in the menu tree and click . 

10. When the read is complete, measurement values appear in Gen5. Select the 
desired data set from the Data list. 

11. Select File > Save and give the experiment an identifying name. 
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Maintenance 
 

Warnings and Precautions 

-WARNING- Internal Voltage. Always turn off the power switch and unplug the power 
supply before cleaning the outer surface of the instrument. 

-WARNING- Liquids. Avoid spilling liquids on the instrument; fluid seepage into 
internal components creates a potential for shock hazard or instrument 
damage. If a spill occurs while a program is running, stop the program and 
turn off the instrument. Wipe up all spills immediately. Do not operate the 
instrument if internal components have been exposed to fluid. 

-CAUTION- Liquids. Do not immerse the instrument, spray it with liquid, or use a 
dripping-wet cloth on it. Do not allow water or other cleaning solution to run 
into the interior of the instrument. If this happens, contact Technical 
Support. Do not soak the touchscreen. 

-CAUTION- Lubricants. Do not apply lubricants to moving parts. Lubricant on 
components in the carrier compartment will attract dust and other particles, 
which may cause the instrument to produce an error. 

-WARNING- 

 

Potential Biohazards. Wear protective gloves when handling contaminated 
instruments. Gloved hands should be considered contaminated at all times; 
keep gloved hands away from eyes, mouth, nose, and ears. 

Mucous membranes are considered prime entry routes for infectious agents. 
Wear eye protection and a surgical mask when there is a possibility of 
aerosol contamination. Intact skin is generally considered an effective barrier 
against infectious organisms; however, small abrasions and cuts may not 
always be visible. Wear protective gloves when handling contaminated 
instruments. 
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Schedule 

Task Frequency 

Clean the touchscreen (if applicable) As needed 

Clean exposed surfaces As needed 

Decontamination Before shipment, storage, or disposal 

Clean the Touchscreen (if applicable) 

-CAUTION- Touchscreen. Avoid strong solvents, such as alcohol, acetone, ammonium 
chloride, methylene chloride, and hydrocarbons. These will permanently 
damage the touchscreen. Avoid fibrous materials, such as paper towels, 
which can scratch the touchscreen. Dirt particles and cleaning agents will 
get trapped in the scratches. Never spray solutions directly on the 
touchscreen. 

Materials 

• Deionized or distilled water 
• Dish soap or other mild cleaner 
• Lint-free disposable towels 

Procedure 

1. Turn off and unplug the instrument.  

2. Moisten a clean, lint-free disposable cloth with water, or with water and mild 
detergent, then thoroughly wring it out so that liquid does not drip from it. Do 
not soak the cloth.  

3. Wipe the touchscreen gently with the moist cloth.  

4. If detergent was used, wipe the touchscreen with a cloth moistened with water.  

5. Dry the screen gently using another cloth.  

Clean Exposed Surfaces 

This procedure is for the housing of the reader. See the previous section for cleaning 
the touchscreen. 

A regular cleaning regimen is recommended to keep the instrument free from dust and 
particulates that can cause erroneous readings. Exposed surfaces may be cleaned (not 
decontaminated) with a cloth moistened (not soaked) with water or water and a mild 
detergent. 

1. Turn off and unplug the instrument from the power supply.  
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2. Moisten a clean, lint-free disposable cloth with water, or with water and mild 
detergent, then thoroughly wring it out so that liquid does not drip from it. Do 
not soak the cloth.  

3. Wipe the plate carrier and all exposed surfaces of the instrument.  

4. If the reader is equipped with a cuvette holder, remove the holder and clean its 
exposed surfaces. 

5. If detergent was used, wipe all surfaces with a cloth moistened, not soaked, with 
water. 

6. Use a clean, dry, lint-free cloth to dry all wet surfaces. 

If liquid is spilled inside the reader, contact Technical Support. 

Decontamination 

• The Epoch 2 requires decontamination prior to shipping, storage, and disposal. 

• Decontamination is required by the U.S. Department of Transportation regulations. 

• Persons performing the decontamination process must be familiar with the basic 
setup and operation of the instrument. 

• Agilent recommends the use of the following decontamination solutions and 
methods based on our knowledge of the instrument and recommendations of the 
Centers for Disease Control and Prevention (CDC). Neither Agilent nor the CDC 
assumes any liability for the adequacy of these solutions and methods. Each 
laboratory must ensure that decontamination procedures are adequate for the 
biohazard(s) they handle. 

Required Materials 

• Sodium hypochlorite (NaClO) 
• 70% isopropyl alcohol (as an alternative to sodium hypochlorite) 
• Deionized or distilled water 
• Safety glasses 
• Surgical mask 
• Protective gloves 
• Lab coat 
• Biohazard trash bags 
• 125-mL beakers 
• Clean, lint-free cotton cloths 

Procedure 

1. Turn off and unplug the reader from the power supply. 

2. Prepare a disinfecting solution: an aqueous solution of 0.5% sodium hypochlorite 
(NaClO). If the effects of sodium hypochlorite are a concern, 70% isopropyl 
alcohol may be used. 
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3. Moisten a clean, lint-free cloth with the disinfecting solution, then thoroughly 
wring it out so that liquid does not drip from it. Do not soak the cloth. 

4. Wipe the plate carrier and all exposed surfaces of the instrument, including the 
inside of the microplate carrier access door and, if equipped, the cuvette holder. 

5. If the instrument is equipped with a touchscreen, place the moistened cloth on 
the touchscreen and it let rest there for 15 minutes, then remove it. 

6. Wait 20 minutes. 

7. Moisten a cloth with deionized or distilled water and wipe all surfaces of the 
instrument that have been cleaned with the disinfecting solution. Do not soak 
the cloth. 

8. Use a clean, dry lint-free cloth to wipe all wet surfaces. 

9. Discard the used gloves and cloths, using a biohazard trash bag and an approved 
biohazard container. 
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Instrument Testing 
 
 

Schedule 

Recommendations for an Epoch 2 used two to five days per week: 

Test Frequency 

System Test Monthly 

Absorbance Tests Monthly 
 

System Test 

Each time the Epoch 2 is turned on, it automatically performs a series of tests on the 
reader’s motors, lamp, and various subsystems. This test can take a few minutes to 
complete. If all tests pass, the microplate carrier is ejected and the green LED on the 
power switch remains on. 

If any test results do not meet the internally coded Failure Mode Effects Analysis (FMEA) 
criteria, the reader beeps repeatedly and the green LED on the power switch flashes. If this 
occurs, press the carrier eject button to stop the beeping.  

If the test fails: Touchscreen models: an error message indicating the problem appears. If 
the problem is something you can fix, turn off the instrument, fix the problem, and turn 
the instrument back on. If the test continues to fail, contact Technical Support. Other 
models: contact Technical Support. 

To run the system test manually: 

1. Turn on the reader and launch Gen5.  

2. Select System > Diagnostics > Run System Test.  

3. When the test is complete, a dialog appears, requesting additional information. 
Enter your user name and other information (if desired), and then click OK. 

4. The results report appears. It should show “SYSTEM TEST PASS”. If it shows  
“SYSTEM TEST FAIL” contact Technical Support. 
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Absorbance Plate Test 

Description 

This test uses the 7-Filter Absorbance Test Plate (Part Number 7260522) to confirm the 
mechanical alignment; optical density accuracy, linearity, and repeatability; and 
wavelength accuracy to NIST-traceable values. The Absorbance Plate Test compares the 
reader’s optical density and wavelength measurements to NIST-traceable values. 

Test Plate Certificates   

To run this test on the Epoch 2, you will need the 7-Filter Absorbance Test Plate (Part 
Number 7260522) with its accompanying certificates. 

Define the Absorbance Test Plate Parameters 

1. Obtain the certificates that came with the Test Plate. 

2. Start Gen5. From the main screen, click System > Diagnostics > Test Plates > 
Add/Modify Plates.  

3. Click Add/Add Plate. The Absorbance Test Plate dialog appears. 

4. Select the appropriate plate type and enter the plate’s serial number. 

5. Enter the last and next certification dates, found on the calibration sticker on the 
Test Plate. Click Help for guidance when setting the wavelengths and entering 
the OD and peak wavelength values. 

6. Review the values you entered, and then click OK to save the data. The 
wavelengths and corresponding calibration data that have been entered will now 
be available in Gen5 each time the Absorbance Plate Test is performed. 

Procedure 

1. From the main screen, click System > Diagnostics > Test Plates > Run.  

2. If prompted, select the desired Test Plate and click OK. 

3. When the Absorbance Test Plate Options dialog appears, select Perform Peak 
Wavelength Test, if it is not already selected. 

4. Highlight the wavelength or wavelengths to be included in this test. Select only 
those wavelengths that are most appropriate for your use of the reader. Enter 
any comments, if desired. 

5. Click Start Test. 

6. Place the Test Plate in the microplate carrier so that well A1 is in the left-rear 
corner of the carrier (as you are facing the carrier). 

7. Click OK to run the test. 
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8. When the test is completed, the results report appears. Scroll through the 
report; every result should show PASS. If any result shows “FAIL”, try the 
following and rerun the test. If the test continues to fail, contact Technical 
Support. 

 Make sure the information entered into Gen5 matches the Test Plate’s 
Certificate. 

 Verify that the Test Plate is within its calibration certification period. If it is 
out of date, contact Technical Support to schedule a recertification. 

 Ensure that the Test Plate is correctly seated in the microplate carrier. 
 Check the alignment (corner) holes on the Test Plate to ensure they are clear 

of debris. 
 Check the filters on the Test Plate to ensure they are clean. If necessary, 

clean them with lens paper. Do not remove the filters from the test plate. Do 
not use alcohol or other cleaning agents. 
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Specifications 
 

 

General Specifications 

Microplates 

The Epoch 2 accommodates standard 6-, 12-, 24-, 48-, 96-, and 384-well microplates 
with 128 x 86 mm geometry; and the Take3 and Take3 Trio Micro-Volume Plates. 

 
Hardware and Environmental 

Light Source Xenon flash light source 

Dimensions 31.8 cm D x 30.5 cm W x 19.6 cm H 

Weight < 6.804 kg (without power supply) 

Environment Operational temperature: 

    18°C to 30°C (models with a touchscreen; “TS”) 
    18°C to 40°C (models without a touchscreen; “NS”) 

Storage temperature range: -25°C to 50°C 

Humidity Operational: 10% to 85% relative humidity (non-condensing) 

Storage: 10% to 80% relative humidity (non-condensing) 

Power Supply 24-volt external power supply compatible with 100–240 V~; 
+/- 10% @50–60 Hz  

Power Consumption < 120W  
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Read Specifications 

All read speeds are +/– 2 seconds. 

 

Endpoint Measurements 

96 Well 

Mode Delay Time 630 nm 630/450 nm 

Normal 100 msec 49 95 

Rapid 0 msec 38 75 

Sweep N/A 15 30 

384 Well 

Mode Delay Time 630 nm 630/450 nm 

Normal 100 msec 169 333 

Rapid 0 msec 131 257 

Sweep N/A 31 56 

 

Kinetic Measurements 

96 Well 

Mode Delay Time 630 nm 

Normal 100 msec 50 

Rapid 0 msec 42 

Sweep N/A 13 

Mode Delay Time 630 nm 

Normal 100 msec 169 

Rapid 0 msec 129 

Sweep N/A 30 
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Optical Performance  

Accuracy, Linearity, Repeatability 

All qualifications were conducted using 96-/384-well, flat-bottom microplates.  
For the performance described here, the Gain on the Optics Test should be <= 8. 

Measurement Range: 0.000 to 4.000 OD                   Resolution: 0.0001 OD 

Accuracy, NIST Filters 
96-well plate, normal read speed, 100-ms delay after plate movement 
0.000–2.000 OD +/-1% +/-0.010 OD 
2.000–2.500 OD +/-3% +/-0.010 OD 
384-well plate, normal read speed, 100-ms delay after plate movement 
0.000–1.500 OD +/-2% +/-0.010 OD 
1.500–2.000 OD +/-5% +/-0.010 OD 
96-well and 384-well plate, sweep read speed 
0.000–1.000 OD +/-1% +/-0.010 OD  

Linearity 
96-well plate, normal read speed, 100-ms delay after plate movement 
0.000–2.000 OD +/-1% +/-0.010 OD 
2.000–2.500 OD +/-3% +/-0.010 OD 
384-well plate, normal read speed, 100-ms delay after plate movement 
0.000–1.500 OD +/-2% +/-0.010 OD 
1.500–2.000 OD +/-5% +/-0.010 OD 
96-well and 384-well plate, sweep read speed 
0.000–1.000 OD +/-1% +/-0.010 OD 

Repeatability, NIST Filters, Standard Deviation 
96-well plate, normal read speed, 100-ms delay after plate movement 
0.000–2.000 OD +/-1% +/-0.005 OD 
2.000–2.500 OD +/-3% +/-0.005 OD 
384-well plate, normal read speed, 100-ms delay after plate movement 
0.000–1.500 OD +/-1% +/-0.005 OD 
1.500–2.000 OD +/-3% +/-0.005 OD 
96-well and 384-well plate, sweep read speed 
0.000–1.000 OD +/-2% +/-0.010 OD 
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Optics 

λ range 200 to 999 nm   

λ accuracy ± 2 nm  

λ repeatability ± 0.2 nm  

λ bandpass < 5 nm  

Detector Photodiodes (2) 
 

 



 

In This Book 
 
This document contains installation, operation, maintenance, and qualification 
information for all models of the Epoch 2. 
 

Document Revision History 

Part 
Number Revision Date Modifications 

1771011I C May 2022 Added Agilent brand information.  

Updated content and symbols to support 2017/746 – In 
Vitro Diagnostic Regulation. 

Replaced the Notices section with Copyright 
information. 

Added Customer Care contact information. 

Removed the Warranty and Product Registration 
section. 

Added information for Getting Started with Gen5. 

 
Original Language – EN 
 

 

Manufactured by Agilent Technologies, Inc. 
5301 Stevens Creek Blvd. 
Santa Clara, CA  95051 
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